
67 2005 3

29
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Cray 1976 27 Cray1
160 8 2

500 8

WINDOWS VEE LabView
WINDOWS GUI Graphic User Interface
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interactive

HT(HP)-BASIC

Measurement and Control by Note PC
- Introduction to HT(HP)-BASIC -

TOMINAGA,  Masaki

Advanced Technology Research Group,
National Research Institute for Earth Science and Disaster Prevention, Japan

Abstract

Measurement and control systems by use of computer are becoming popular. Most of them that we can use in daily 
experiments are offered in the form of pre-fi xed systems. The pre-fi xed systems are designed to remove complexity in 
the setup of the instrumentation and control systems. It is true that the hardware is well combined with the software in 
those systems, but it is diffi cult or impossible for us to modify them for our own use. On the other hand the published 
software that have fl exibility in use are so well designed that researcher cannot see what is going on in the systems or the 
programs. In the present paper HT-BASIC is introduced for the use of  instrumentation and control by use of  note PC. 
The HP-BASIC was a well acknowledged software to control measurement systems by PC. Researchers could manipulate 
them for their own use. Since discontinuance of the PC specifi ed for the use of the HP-BASIC the software became 
unpopular. But new version of the HP-BASIC those name was changed to “HT-BASIC for WINDOWS” is designed to 
work well in WINDOWS environment. We can make personal systems for instrument and control by the “HT-BASIC for 
WINDOWS” without much diffi culty.

Key words : Note PC, BASIC, Field instrumentation, Instrumentation, User oriented instrumentation system
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HT HP -BASIC

HT HP -BASIC

2. HT HP -BASIC
30 1970

CAMAC

Operational Amplifi er Texas Instruments IC

Hewlett-Packard HP HPIB Hewlett-Packard Interface Bus
1973 desktop computer HP

HP 1975 IEC
GPIB General Purpose Interface Bus HP HPIB

HP
A/D

D/A

1977 HP HP9825A GPIB

32 250kbyte 16
RAM 6.8k

HP9825A HPL Hewlett-Packard Language
CRT

HP-BASIC Rocky Mountain Basic HP

LA Laboratory 
Automation FA Factory Automation
GUI HP-BASIC Plus 

1986 Toshiba USA T-3100
HP-BASIC

IBM PC Intel CPU Motorola CPU
Intel 68

Motorola CPU HP 1990
HP

HP-BASIC
HP9000/300 1996 10 HP HP-BASIC

6.2
IBM PC OS WINDOWS HP-BASIC TransEra

1988 IBM PC HP-BASIC Rocky Mountain Basic HP 1996
2000 11 HP-BASIC for WINDOWS TransEra OEM
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HP-BASIC

HP-BASIC CPU
Motorola 68 CPU Intel

HP-BASIC for WINDOWS

HP VEE TransEra HP-BASIC for WINDOWS
HP

HP-BASIC WINDOWS
C

C C
C WINDOWS

HP VEE National Instruments NI LabVIEW
NI

HP PC

PC

HP-BASIC all in one
TransEra HT-BASIC for WINDOWS

HPIB GPIB
GPIB GPIO General Purpose Input and Output I/O

PC HT HP -BASIC 40 50
HT HP -BASIC

HP
1 300

HP-BASIC

HT HP -BASIC

1974 3

HP HPIB
HPIB HP

HP GPIB
GPIB

HT HP -BASIC GPIB
HP-BASIC TransEra HT-BASIC HP

WINDOWS GUI Graphic User Interface
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3. HT-BASIC 1,2

HP HP-BASIC TransEra HT-BASIC
HT-BASIC 9.2 HT-BASIC

HT-BASIC GPIB CRT

1 GPIB
GPIO GPIB

PC PCMCIA
3.1 HT-BASIC
1 interpreter

HT-BASIC
interpreter C Fortran

RUN

→ → C

C
BASIC

C BASIC

2
HT-BASIC

1 HT HP -BASIC
Fig. 1 HT HP -BASIC and its environment.
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3 BASIC
BASIC BASIC

C 7

4

HT-BASIC CSUB C
CSUB
5

6 GPIB:
HT-BASIC GPIB

PC GPIB GPIB GPIB
USB GPIB

7 GPIO
I/O GPIB PC I/O

GPIO HP 16
I/O GPIO PCI

I/O PC NI INES DAQ Data Acquisition 5
A/D 8 24

AD PC

8 HT-BASIC Plus
HT-BASIC Plus

GUI
HT-BASIC

HP-BASIC HT-BASIC Plus
9

CRT GPIB HPGL
CRT HT-BASIC

Windows

3.2 HT-BASIC
1

HP-BASIC HP-BASIC TransEra HT-BASIC for WINDOWS 9.2
HT-BASIC

40M

C:\Program Files\HTBwin92

2 GPIB
NI GPIB

3 I/O
INES DAQ  i250 INES

i250
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4. HT-BASIC 1
HT-BASIC

4 5 6 7

4.1
interpreter HT-BASIC

C FORTRAN
ENTER

HT-BASIC

example
HT-BASIC for WINDOWS Ver. 9.2

example
Help

1 EDIT

C:\Program Files\HTBwin92

HTBwin.exe File→New Edit
→Edit Mode

2
EDIT

10  INPUT A !

20  PRINT 3*A !

30  PAUSE !

40  END !

ENTER !

!

RUN ENTER

Run

?

5 ENTER 15

30 A 5

A ENTER

5

A=123 ENTER

A ENTER 123 A 123

CONT 20 ENTER

20 3*123 369

CONT ENTER
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END

EDIT → →SAVE AS
SAVE

"SAVE"

"GET"

3
EDIT

10  INPUT A$ !

20  PRINT "Abc"&A$ !

30  PAUSE !

40  END !

10 A$ $ ?

def ENTER

"Abcdef" 30 PAUSE 20
& " " "Abc" A$

A$ ENTER

"def" " "

A$ "xyz" ENTER

A$

CONT 20 ENTER

"Abcxyz"

30
CONT ENTER

END

C
4

HT-BASIC STORE SAVE 2
STORE STORE LOAD LOAD

LOAD ASCII
SAVE SAVE GET GET

LOAD ASCII
HT-BASIC

LOAD LOAD GET

5
F9

Shift + F9

System → User1 → User2 → User3

System Run F3

Pause F4 Continue F2

Stop F4 idle
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3
list key + 

ENTER LIST KEY #10 + ENTER #10

4.3 2
4.2

1 GPIB
PC GPIB GPIB
GPIB NI GPIB GPIB HP 3457A

2 NI PC GPIB

10  ASSIGN @hp3457 TO 722  !I/O

20  OUTPUT @hp3457;"NPLC .0005"  !hp3457

30  OUTPUT @hp3457;"DCV AUTO,.033" !hp3457

40  WAIT 1 ! 1

50  ENTER @hp3457;B$  !hp3457

60  PRINT B$,VAL(B$) !

70  CLEAR 722 !I/O

80  END

10 ASSIGN I/O 7 GPIB 22 I/O I/O
7 GPIB 22 GPIB

0 32 GPIB
ASSIGN @hp3457 722 I/O

ASSIGN @hp3457 722

20 30 @hp3457 I/O 722

HP3457A

20 AD 30 DC

40 1

50 @hp3457 722 I/O

60 VAL(B$) B$

60
70 @hp3457 I/O
GPIB

GPIB
GPIB HT-BASIC GPIB

NI GPIB GPIB

LOAD BIN "GPIBNI"

BIN "GPIBNI"

C:\Program Files\HTBwin92
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LOAD BIN "C:\Program Files\HTBwin92\GPIBNI"

LOAD BIN "GPIBNI" GPIB

5
CSUB

CSUB
HP-BASIC HP-BASIC GPIB

HP GPIB
WINDOWS PC

GPIB PC

NI GPIB 4.2 3
LOAD BIN "GPIBNI" GPIB

1 HT-BASIC Ver.9.2 GPIB
PC WINDOWS OS

2 GPIB
Fig. 2 GPIB card and cable national instruments Co.

1 HT-BASIC 9.2 GPIB
WINDOWS OS

Table  1 GPIB supported by the HT-BASIC 9.2.
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2 GPIO
GPIB GPIB

HP
HP9000/300 GPIB GPIO

16 HP-BASIC
PC PCI GPIO HT-BASIC

PC 16
A/D PC A/D

GPIB
PC A/D

5
3

HT-BASIC AUTOST

AUTOST LOAD HP
HP9825A

AUTOST

AUTOST

AUTOST

C:\Program Files\HTBwin92

"LOAD" HT-BASIC
AUTOST Edit → Edit Mode

AUTOST

!

RE-STORE

LOAD RE-STORE AUTOST

CSUB CSUB

(LOAD) / RE-STORE (GET) / SAVE

CSUB AUTOST 

LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

CSUB CSUB

"SAVE" CSUB "SAVE" "GET"

Edit CSUB

RUN

4.3
HT-BASIC

1
HT-BASIC
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10   MASS STORAGE IS "d:\hp\temp"  !

20   CREATE "test.txt",0  !

30   ASSIGN @File TO "test.txt"; FORMAT ON ! I/O

40   FOR I=1 TO 5 !

50      INPUT "numeric, characters",A,B$  !

60      PRINT A,B$

70      OUTPUT @File;A,B$  !

80   NEXT I

90   RESET @File  !

100  PRINT "------"

110  FOR I=1 TO 5

120     ENTER @File;C,D$  !

130     PRINT C,D$

140  NEXT I

150  ASSIGN @File TO * !I/O

160  END

10 Mass 

Storage Is MSI "d \hp\temp" Mass Storage Is

20 10 test.txt HP-BASIC
.txt test.txt

ASCII WINDOWS
EXCEL

WINDOWS
0

30 @File test.txt I/O FORMAT ON

ASCII FORMAT OFF

ASCII OS ASSIGN FORMAT 

ON

40 80 FOR NEXT

50 2 INPUT 50 "  "
, ENTER

60 70 80

90 90
100 "  "

110 140 C D$

150 I/O ASSIGN I/O
* I/O

I/O
ASCII WINDOWS

EXCEL
2

10   OPTION BASE 1 !

20   DIM P$[11],Q$[8]  ! (number)[length]

30   DIM A$(3)[18],B$(1:5)[20],C$(1:5)[22] !(from:end)[length]
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40   MASS STORAGE IS "d:\hp\temp\"  !

50   FOR I=1 TO 3 ! I

60      LOOP

70         P$=DATE$(TIMEDATE) !dd Mmm yyyy

80         Q$=TIME$(TIMEDATE)  !hh:mm:ss

90         EXIT IF Q$[8;1]="0"  ![from;lenth]

100     END LOOP

110     A$(I)="data("&Q$[1,2]&"-"&Q$[4,5]&"-"&Q$[7,8]&").txt"

 ![from,end]

120     CREATE A$(I),0 !

130     FOR J=1 TO 5

140        B$(J)=P$&" "&TIME$(TIMEDATE)

150        WAIT 1 ! 1

160     NEXT J

170     ASSIGN @File TO A$(I);FORMAT ON !I/O

180     OUTPUT @File;B$(*)  !

190  NEXT I

200  CAT "d:\hp\temp"  !

210  FOR I=1 TO 3

220     PRINT "------"

230     PRINT A$(I)

240     ASSIGN @File TO A$(I);FORMAT ON

250     ENTER @File;C$(*) !

260     FOR J=1 TO 5 !

270        PRINT C$(J)

280     NEXT J

290  NEXT I

300  ASSIGN @File TO * !I/O

310  END

HP-BASIC DIM 10
1 OPTION BASE 1 0

OPTION BASE 0

20
18 20 70 80 P$ Q$

30 A$(3)[18] 18 3 B$(1:5)[20]

1 5 20 5 DIM

40
50 190 FOR NEXT

60 100 90
70 TIMEDATE 48 P$=DATE$(TIMEDATE)

P$ 11 Apr 2004

11
80 Q$=TIME$(TIMEDATE) 12:54:32 : : 8

90 60 100 Q$[8;1]="0" Q$ 8 1
"0" 1 Q$ 10
110 A$(I)

A$(I)="data("&Q$[1,2]&"-"&Q$[4,5]&"-"&Q$[7,8]&").txt"
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"data("&Q$[1,2] "data(" Q$[1,2] &

Q$[1,2] Q$ 1 2 110
A$(I) 18 "data(hh-mm-ss).txt"

90 110 2
HT-BASIC

120 A$(I)

130 160
140 P$ " " TIME$(TIMEDATE)

150 1

B$(J)=P$&" "&TIME$(TIMEDATE)

70 P$ "11 Apr 2004 12:54:33"

170 A$(I) I/O ASCII
180 B$(*) (*)

200 CAT
CAT 

CAT Directory$ TO #10

Directory$

WINDOWS #10 WINDOWS
DOS

HT-BASIC
Tool→Device Setup→Win-Print→Properties→Select Font→MS

210 290 3

220
230
240 A$(I) I/O ASCII
250 C$(*)

260 280
300 I/O

130 160 4.2 1 GPIB

5. HT-BASIC 2 PC InesDAQ i250 3

Elan AD132 PC 16 A/D
8 I/O A/D 12 250kHz

Elan A/D
Elan

Ines Ines  InesDAQ i250 3 InesDAQ i250 PC
i250 InesDAQ  i250  

A/D 16 A/D 16 1 A/D 
16

5.1 InesDAQ i250 PC
A/D 12 16 A/D 305.1Hz
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250kHz
1

250 kHz 90 kHz
250 kHz 10 +10 16

8 1
16 2

8
TTL 0V Low 0.8V 2V High 5V 8

1,2,4,8 3
37 D-sub plug I/O

2
5.2 A/D

InesDAQ i250 A/D

1 1 1
InesDAQ i250 PC

CSUB  i250 
A/D

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   DIM A(1)  !

40   INTEGER Dummy, Hadc,Cadc 

50   DIM L$[256]  !256

60   CALL Daqhtb_ioctl(Dummy,"( fctn init ) ")  !PC

70   CALL Daqhtb_open(Hadc,"i250 ADC",0) !A/D 0

80   L$="( ioa ( timeout 10000 fsmpl 100000 chan 1 iomode single trigmode off

 samples 1 range [ -10 10 ] ) )" !A/D

90   CALL Daqhtb_ioctl(Hadc,L$) !PC A/D

100  CALL Daqhtb_read(Cadc,Hadc,A(*)) ! 1

110  PRINT A(1) !

120  CALL Daqhtb_close(Hadc) !PC

130  END

10 HT-BASIC InesDAQ CSUB
InesDAQ CSUB

3 InesDAQ i250
Fig. 3 InesDAQ i250 and cable Ines Co. .
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20 1
30 A 1
40 Dummy Hadc Cadc InesDAQ

50 256
60 PC

CALL Daqhtb_ioctl(Dummy,"(fctn init)")

Dummy InesDAQ 2
"(fctn init)" PC

FIFO 1M IRQ interrupt request
8192
70 PC A/D "i250 ADC" i250  ADC A/D

Hadc "i250 ADC" PC
CSUB Hadc

0

1

80 A/D 2
ENTER> 2

80 50 DIM

P$[128],Q$[128]

　50  DIM L$[256],P$[128],Q$[128]

　・・・・・・
　75  P$="( ioa ( timeout 10000 fsmpl 100000 chan 1 iomode single"

　76  Q$="trigmode off samples 1 range [ -10 10 ] ) )"

　80  L$=P$&" "&Q$

2 InesDAQ PC
Table  2 Pin assignment of InesDAQ i250.
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 ioa I/O A/D (  )

timeout 10000 ! 10000

fsmpl 100000 ! 100 kHz

chan 1 !1 A/D

iomode single !

trigmode off !

samples 1 ! 1

range [-10 10] ! 10 +10

2 16 2
2のように 8

16 8
90 80 Hadc

100 A(*) 1
A(*) 1 1 Cadc

110
120 PC InesDAQ

130
InesDAQ 5 CSUB

PC

A/D I/O

PC

4
2 1

1 1

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"       !CSUB

20   OPTION BASE 1

30   DIM A(2),L$[256]

40   INTEGER Dummy,Hadc,Cadc

50   CALL Daqhtb_ioctl(Dummy,"( fctn init) ")

60   CALL Daqhtb_open(Hadc,"i250 ADC",0)

70   L$="( ioa ( timeout 10000 fsmpl 100000 chan 102 iomode single

 trigmode off samples 2 range [ -10 10 ] ) )"

80   CALL Daqhtb_ioctl(Hadc,L$)

90   CALL Daqhtb_read(Cadc,Hadc,A(*))

100  PRINT A(1),A(2)

110  CALL Daqhtb_close(Hadc)

120  END

30 2 A(*)

50 PC
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60 0 A/D open
70 2

ENTER>

fsmpl 100000 ! 100 kHz

chan 102 ! 1 2 A/D

samples 2 ! 2

trigmode off ! OFF

A/D InesDAQ
1

0

A/D
2

A/D 2 100kHz
80 PC Hadc L$

90 1,2 1 2 1 A(1) 2
A(2)

100
110 PC

1 2 6
4.3 1 2

3 1
1

1 250 kHz

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   DIM A(1024) ,L$[256]

40   INTEGER Dummy, Hadc,Cadc

50   CALL Daqhtb_ioctl(Dummy,"( fctn init) ")

60   CALL Daqhtb_open(Hadc,"i250 ADC",0)

70   L$="( ioa (timeout 10000 fsmpl 100000 chan 1 iomode single

 trigmode level.gt triglevel -10.0 pretrig 0 samples 1024 range [ -10 10 ] ) )"

80   CALL Daqhtb_ioctl(Hadc,L$)

90   CALL Daqhtb_read(Cadc,Hadc,A(*))              !64(2^6) < A(*)=2^n < 16348(2^14)

100  --------------------------------------

110  CALL Daqhtb_close(Hadc)

120  END

30 A(*)

60 0

70 2
ENTER>

fsmpl 100000 ! 100 kHz

trigmode level.gt !

triglevel -10.0 ! 10

pretrig 0 !
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samples 1024 ! 1024

64(2^6) 16348(2^14) 2^n

trigmode off A/D
pretrig

80 A/D
90 A(*)

1 70
10V +10V 2

31
4

A/D
90 kHz

2個の A/D

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   DIM A(1024),Dat(512,2),L$[256] !

40   INTEGER Dummy,Hadc,Cadc

50   CALL Daqhtb_ioctl(Dummy,"(fctn init)")

60   CALL Daqhtb_open(Hadc,"i250 ADC",0)

70   L$="( ioa ( timeout 10000 fsmpl 90000 chan 102 iomode single

 trigmode off samples 1024 ) )"

80   CALL Daqhtb_ioctl(Hadc,L$) 

90   CALL Daqhtb_read(Cadc,Hadc,A(*))  ! A(*)

100  CALL Daqhtb_close(Hadc)

110  FOR J=1 TO Cadc/2. !

120     Dat(J,1)=A(2*J-1)

130     Dat(J,2)=A(2*J)

140  NEXT J

150  END

30 2 A(*) 1024

512 Dat(*)

50 PC
60 PC A/D 0

70 2
ENTER>

fsmpl 90000 ! 90 kHz

chan 102 ! 1 2 A/D

iomode single !

trigmode off !

samples 1024 !2 1024

A/D 16
8 2

80 PC
90 A/D
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A(*) 2 1024 Cadc

100
110 140 A(*) 1 2

Cadc 2

2 PC
32 4 HT-BASIC 16 2

2
256 2^n

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   INTEGER A(1024)  !

40   DIM R(512),Dat(256,2) !

50   INTEGER Dummy,Hadc,Cadc !

60   DIM L$[256] !

70   CALL Daqhtb_ioctl(Dummy,"(fctn init)") !PC

80   CALL Daqhtb_open(Hadc,"i250 ADC",1) ! (1)

90   L$="( ioa ( timeout 10000 fsmpl 100000 chan 102 iomode single

 trigmode off samples 1024 ) )"

100  CALL Daqhtb_ioctl(Hadc,L$)

110  CALL Daqhtb_readi(Cadc,Hadc,A(*))  !  

120  CALL Daqhtb_demangle(R(*),A(*),L$,0)  !

130  CALL Daqhtb_close(Hadc)

140  FOR J=1 TO Cadc/2. !

150     Dat(J,1)=R(2*J-1)

160     Dat(J,2)=R(2*J)

170  NEXT J

180  END

30 A/D binary PC 32
HT-BASIC 2 16 1 2

A(1024) 512

40 R(512) A(*) 1024

Dat(256,2) 256

80 PC A/D 1

90 2
ENTER>

fsmpl 100000 ! 100 kHz

chan 102 ! 1 2 A/D

iomode single !

trigmode off !

samples 1024 !2 1024

110 A(*) A 2 PC 1
samples 1024 512 A

100 PC
110 A(*) Daqhtb_read

integer Daqhtb_readi
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120 A(*) 1024

512 R(*) 512

130
140
5.3

InesDAQ i250 I/O 8
3

3 1 2 4 8

1
CSUB A/D

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   DIM D(1)

40   INTEGER Dummy,Hdio,Cdio

50   CALL Daqhtb_ioctl(Dummy,"(fctn init)") !

60   CALL Daqhtb_open(Hdio,"i250 DIO",1)  ! I/O

70   CALL Daqhtb_ioctl(Hdio,"( iod ( dir 255 ) )") ! I/O

80   INPUT P  ! 10

90   D(1)=BINAND(P,255)  !2 8

100  CALL Daqhtb_write(1,Hdio,D(*))

110  CALL Daqhtb_close(Hdio)

120  END

10 PC CSUB

20 0 1

30 1 D(*)

60 InesDAQ i250 I/O
70 2 I/O 8
80
90 8 D(1) BINAND(A,B) 2 A B

16 AND

100 1
110
2

70

10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   DIM D(1) !

40   INTEGER Dummy,Hdio,Cdio

50   CALL Daqhtb_ioctl(Dummy,"(fctn init)")  !

60   CALL Daqhtb_open(Hdio,"i250 DIO",1) ! I/O

70   CALL Daqhtb_ioctl(Hdio,"( iod ( dir 0 ) )") !8

80   ----------

90   CALL Daqhtb_read(Cdio,Hdio,D(*)) ! D

100  CALL Daqhtb_close(Hdio) !

110  END



49

70 8
TTL 0V Low 0.8V 2V High 5V 4 GPIO 16

GPIO 16
2 16 100

5 InesDAQ i250 I/O 16
8

6 HT-BASIC 3
C

1 FOR NEXT IF THEN LOOP WHILE REPEAT SELECT CASE

FOR NEXT

10   FOR I=1 TO 100

20      FOR J=2*PI TO 0 STEP PI/100

        -----

80      NEXT J

90   NEXT I

3 I O
Table  3 Assignment code of InesDAQ digital Port I : input, O : output .

4 GPIO 16
Fig. 4 An external actuator of GPIO output.

5 Ines DAQ i250
Fig. 5 An external test board of Ines DAQ i250.
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20 2π 0 π/100 STEP 1

IF THEN ELSE END IF

true 1

10   IF J2=K THEN 90

        -----

30   IF X=Y THEN Y=Z*Z

        -----

40   IF A<0 THEN

50      GOTO End

60   ELSE

        --------

80   END IF

90 End:END

10 J2=K true 90

30 true Y=Z*Z

40 80 A<0 true End 90 false ELSE

:
LOOP EXIT IF END LOOP

100  LOOP

        ----

170  EXIT IF J=5 OR A$>B$

        ----

190  END LOOP

100 190 170 true LOOP

WHILE END WHILE

100  WHILE X<1000

        -----

200  END WHILE

100 true 200
REPEAT UNTIL

60   REPEAT

        ----

80   UNTIL X=10

80 true REPEAT

SELECT CASE END SELECT

10   SELECT Option$

20   CASE "B"

30      A=1

40   CASE "0" TO "9","y","n"

50      A=2

60   CASE ELSE

70      A=0
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80   END SELECT

10 Option$ 20 40 CASE

Option$="B" true 30 CASE 70
SELECT

2 1 SUB COM FN

10   CALL Mysub !

20   END !

30   SUB Mysub !

40      PRINT "In My SUB"

50   SUBEND

10 20 Mysub

END

COM

10   COM /Test/A$(2)[20],P  !

20   A$(1)="He"

30   A$(2)="llo"

40   P=7

50   Subit  !

60   END  !

70   SUB Subit !

80   COM /Test/C$(*),R  !

90      PRINT "A$(*)=";C$(1)&C$(2),"P=";R !

100  SUBEND

10 COM /Test/

50 CALL CALL Subit

CALL

80

10   DIM A$(2)[20]

20   A$(1)="He"

30   A$(2)="llo"

40   P=7

50   Subit(A$(*),P,Q) !

60   PRINT Q

70   END

80   SUB Subit(C$(*),R,S) !

90      PRINT "A$(*)=";C$(1)&C$(2),"P=";R

100     S=R*R !

110  SUBEND

80 50 SUB

80 C$(*) 81 10
3 2 GOSUB FN CSUB
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GOSUB

HP-BASIC GOSUB

RETURN GOSUB

10   Y=3

20   Z=4

30   GOSUB Calc_x

40   PRINT "X = ";X

50   STOP

60 Calc_x:X=Y*45/Z

70   RETURN

80   END

30 60 70 RETURN 50 STOP 60 70
STOP END idle CONTINUE

DEF FN

10   PRINT "5 + 8 =";FNAdd(5,8) !

20   END !

30   DEF FNAdd(A,B) !

40      RETURN A+B

50   FNEND

30 50 FN CALL 

CSUB

HT-BASIC

10   LOADSUB ALL FROM "C:\Program Files\HTBwin92\mathlib\Mathlib.hts"

        -----

100  A=FNErf(X)

        -----

300  END

100 X FNErf(X) A FNErf(X)

C:\Program Files\HTBwin92\mathlib\Mathlib.hlp

10

C:\Program Files\HTBwin92\mathlib\Mathlib.hts

CSUB

CSUB ASCII
RE-STORE LOAD

4 MAT

MAT
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10   OPTION BASE 1  !

20   DIM A(3,3),B(3,3),C(3,3) !3 3

30   DIM V1(3),V2(3) !1 3

40   DATA 1,3,2, 1, 2, 1,2,4,3 !

50   RESTORE 40 ! READ DATA

60   READ A(*) !A(*) DATA

70   CALL Subdisp1("A(*) = ",A(*)) ! A(*)

80   MAT B=INV(A) !A(*) B(*)

90   Subdisp1("INV A(*) = ",B(*)) !B(*)

100  MAT C=B*A !B(*) A(*) C(*)

110  Subdisp1("INV(A)*A = ",C(*)) !C(*)

120  MAT V1=B(1,*) !B(1,*) V1(*)

130  Subdisp2("INV(1) = ",V1(*)) ! V1(*)

140  MAT V2=V1*A ! V1(*) A(*) V2(*)

150  Subdisp2("INV(1)*A = ",V2(*)) !V2(*)

160  END !

170  SUB Subdisp1(P$,Q(*)) ! 1

180     PRINT "" !

190     PRINT P$

200     FOR I=1 TO 3

210        PRINT USING "3(10D.DD)";Q(I,1),Q(I,2),Q(I,3) !

220     NEXT I

230  SUBEND

240  SUB Subdisp2(P$,Q(*))  ! 2

250     PRINT ""

260     PRINT P$

270     PRINT USING "3(10D.DD)";Q(*) !

280  SUBEND

40 DATA ,
50 READ DATA

60 A(*) DATA DATA

P(2,3,2)

P(1,1,1) P(1,1,2) P(1,2,*) P(1,3,*) P(2,1,*) P(2,3,*)

70 A(*)

80 A(*) B(*) 100 B(*) A(*) C(*)

MAT

90 110 70 CALL

120 B(1,*) V1(*)

130 150
140 V1(*) A(*) V2(*) V1(*)

MAT V2=V1*A V1(*)

MAT V2=A*V1 V1(*)

170 230 240 280
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(P$,Q(*))

210 270

PRINT USING "3(10D.DD)";Q(I,1),Q(I,2),Q(I,3)

"3(10D.DD)" 10 2 3
; 270 Q(*) HP-BASIC 

IMAGE

example 
5

true 1 false 0

PRINT ((A=B) OR (C>D))*PI

(A=B) (C>D) false 0 PI

6
16

BINAND(A,B) ! 16 AND

BINCMP(A)  !16

BINEOR(A,B) ! 16

BINIOR(A,B) ! 16 OR

BIT(A,5) !16

ROTATE(A,2) !16

SHIFT(A,2) !16

BIT 5 OPTION BASE

0 15 ROTATE 2

SHIFT 2

0

7
2 8 16

COMPLEX A,B !

A=CMPLX(2,1) !A=2+i

B=CMPLX(5,1/5)*A !B=(5+i1/5)*(2+i)=9.8+i5.4

7. HT-BASIC 4
HP-BASIC

7.1
1

6

10   GINIT !

20   PLOTTER IS CRT,"INTERNAL" !

30   Xlow=-1 !

40   Xhigh=1 !

50   Xlength=Xhigh-Xlow !

60   Ylow=-1 !

70   Yhigh=1 !
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80   Ylength=Yhigh-Ylow !

90   VIEWPORT 40,120,20,90 !

100  WINDOW Xlow,Xhigh,Ylow,Yhigh !

110  FRAME !

120  AXES Xlength/20,Ylength/20,0,0,5,5,2 !

130  CLIP OFF !

140  F$="F(X)=X*X*X" !

150  MOVE 0,Yhigh !

160  LORG 4 !

170  LABEL F$ !

180  CLIP ON !

190  PEN 6 !

200  FOR X=Xlow TO Xhigh STEP Xlength/20 !

210     PLOT X,X*X*X !

220  NEXT X

230  CSIZE 3 !

240  LORG 1 !

250  PEN 2 !

260  FOR X=Xlow TO Xhigh STEP .5 !

270     MOVE X,0 !

280     LABEL X !

290  NEXT X

300  FOR Y=Ylow TO Yhigh STEP .5 !Y

310     MOVE 0,Y !

320     LABEL USING "DD.D";Y !

330  NEXT Y

340  END

10 LABEL

20

PLOTTER IS 712,"HPGL"

GPIB 12
"HPGL" Hewlett Packard Graphic Language HP

30 80 X Y

90 VIEWPORT

VIEWPORT

Y 100 X

HT-BASIC GDU Graphic Display Unit
Y 100 X 100

RATIO

RATIO X Y 1.4

RATIO 1.4 Y 100 X

140

VIEWPORT 
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90 140 40 120

100 20 90

RATIO RATIO

Xscale=100*RATIO

VIEWPORT 0.3*Xscale,0.7*Xscale,20,80

X 30% 70% Y 20 80

100 VIEWPORT 30 80

WINDOW Xlow,Xhigh,Ylow,Yhigh

1 1 1 1
110
120

AXES Xt Yt Ox Oy Cx Cy S

Xt X

Yt X

Ox Y X

Oy X Y

Cx X

Cy Y

S VIEWPORT

120

AXES Xlength/20,Ylength/20,0,0,5,5,2

Xlength/20,Ylength/20, X X 20

Y

0,0, XY

5,5, XY 5

2 2

130 180
PRINT PRINT

LABEL

130 90 VIEWPORT CLIP OFF

140 .
150 X 0 Y Yhigh Yhigh

100 VIEWPORT

130

160 150 1 9
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3 6 9

2 5 8

1 4 7

160 LORG 4 150

170
180 VIEWPORT

190 0 15

0(black),1(white),2(red),3(yellow),4(green),5(cyan),

6(blue),7(magenta),8(black),9(olive green),10(aqua),

11(royal blue),12(maroon),13(brick red),14(orange),15(brown)

200 220 PLOT

210 (X,X*X*X)

230 290 X
230 LABEL GDU 80

CSIZE 2

CSIZE ,

GDU
 0.6 

240 150
250 2 red
260 290 0.5 X

300 330 0.5 Y 320 6 4
210

6 .

2
InesDAQ i250

6
Fig. 6 A graphic output.
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10   LOADSUB ALL FROM "c:\InesDAQ\htbasic\daqhtb.csb"

20   OPTION BASE 1

30   DIM A(1),B(1024) ! Data arrays

40   INTEGER Dummy, Hadc,Cadc 

50   DIM L$[256] ! Label for confi guring ADC card

60   CALL Daqhtb_ioctl(Dummy,"(fctn init)")

70   CALL Daqhtb_open(Hadc,"i250 ADC",0)

80   L$="(ioa(timeout 10000 fsmpl 100000 chan 1 iomode single trigmode off

 samples 1 range [-10 10]))"

90   PEN 3

100  AXES 5,5,0,50,2,2,2

110  PEN 1

120  MOVE 0,50

130  FOR I=1 TO 101

140     CALL Daqhtb_ioctl(Hadc,L$) 

150     CALL Daqhtb_read(Cadc,Hadc,A(*))

160     DRAW I,A(1)*4+50

170     B(I)=A(1)

180     WAIT .1

190  NEXT I

200  FOR I=1 TO 101 STEP 10

210     PRINT I,B(I)

220  NEXT I

230  CALL Daqhtb_close(Hadc)

240  END

80 2
ENTER>

90 120
130 190 InesDAQ i250
200 220
7.2

3
GPIB

20 PLOTTER IS CRT,"INTERNAL"

PLOTTER IS 712,"HPGL"

GPIB 12 "HPGL" "HPGL"

HP "HPGL"

HP
MYPLOT "HPGL"

"HPGL"

WINDOWS

Alt  Print Screen

→ → → → →
→ → → →
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Alt Print Screen

→ → → WINDOWS
→ → →

jpg Adobe
→ 3

Print Screen  Alt

7.3 HT-BASIC Plus
HT-BASIC GUI HP-BASIC Plus

HT-BASIC for WINDOWS Ver.9.2

GUI HT-BASIC
HP-BASIC Plus HP-BASIC Plus 

10   MASS STORAGE IS "C:\Program Files\HTBwin92\"

20   LOAD BIN "BPLUS" !HP-BASIC Plus 

30   DIM S1$(0:1)[10],P$[20]

40   INTEGER Btn

50   S1$(0)="Abort"

60   S1$(1)="Continue"

70   P$="Error is caused"

80   DIALOG "ERROR",P$,Btn;SET("DIALOG BUTTONS":S1$(*)),TIMEOUT 5

90   SELECT Btn

100  CASE =-1 !Btn=-1 

110     PRINT Btn

120     DISP "Timeout"

130  CASE =0

140     PRINT Btn

150     DISP S1$(Btn)

160  CASE =1

170     PRINT Btn

180     DISP S1$(Btn)

190  END SELECT

200  END

HP-BASIC Plus 10 20

LOAD BIN "BPLUS"

80 "ERROR"

DIALOG "ERROR",P$,Btn;SET ("DIALOG BUTTONS":S1$(*)),TIMEOUT 5

"ERROR" P$

70 Btn 0 1 2

-1

SET ( ) TIMEOUT 5 5
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"Abort" "Continue" 2
0 1 3

5 -1 "Timeout"

HT-BASIC Plus 10 diagrams 30 widgets
HT-BASIC Plus "plus 

examples"

7 1 HT-BASIC

8.

15  _ 

$

Data Name

8 ± 15 ±308

MAXREAL MINREAL

2 32768 32767

1 /1 18 DIM

) Data$ 18

REAL X,A(5) REAL

INPUT X X

DIM A(5) 5

DIM Data(10:14) 10 ~ 14 5

INTEGER Y,B(5)

2 8 16

COMPLEX A,B

DIM Name$[20] 20

INPUT B$ B$ 18

DIM Name$(5) 5 18

DIM Name$(10:14)[20] 10 14 20

6

32767

DIM A(5) 5

OPTION 0  0 4 

OPTION 1  1 5 

     ()  

     FN  

     ^   

     * / MOD DIV  MOD DIV

     +      

     =  ,  ,  ,  ,  

     NOT       



61

     AND       

     OR , EXOR 

+  , * MOD DIV 

     DROUND(A,12)=DROUND(B,12) 12

     ABS(A B)<=1E-10 

9.
1 2

3

AD

HT-BASIC 3 all-in-one
HT-BASIC

HT-BASIC

WINDOWS
HP-BASIC

C BASIC
LabVIEW

LabVIEW C

3 1 RUN
1977 8 23

Dr. Paul B. MacCready Gossamer Condor 8 HP
HP9820A Dr. Peter Lissaman

HP9820A
4 1978

2 1979 Gossamer Albatross
HT-BASIC

HT-BASIC
GPIB

HT-BASIC
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InesDAQ i250 GPIB

（ 2004 10 28 ）
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HT-BASIC

GUI
GUI C

HT-BASIC HP HP-BASIC
WINDOWS
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